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Renaming Clips Using Display Names
The most fundamental piece of clip metadata is each clip’s name, which is used to identify clips 
nearly everywhere they appear inside Resolve. By default, clips show the file name of the 
corresponding media file on disk. Since the dawn of tapeless recording, however, editors have 
been stuck with camera original media having names that are not exactly “human readable.” 

Fortunately, you have the option of entering a more user-friendly display name to use instead, 
while preserving the original file name that’s critical for maintaining the link between a clip and 
its media, as well as for tracking an offline clip’s corresponding link to the online media from 
which it originated. There are a few ways you can edit the display name of a clip.

To edit a clip’s display name, do one of the following:

�� In the Media Pool’s List view, show the Display Name column (hidden by default). By 
default, the Display Name mirrors the source clip’s file name, but you can click the 
Display Name column for any clip to add a new name from scratch.

�� With the Display Name column exposed in the Media Pool’s List view, Option-click 
the Display Name column for any clip to edit the file name, rather than entering a 
brand new name.

�� To edit the display name of multiple clips, select all of the clips for which you want to 
change the display name, then right-click one of the selected clips and choose Clip 
Attributes. Open the Name panel of the Clip Attributes window, edit the Display Name 
field, and click OK.

After you’ve changed a clip’s display name, that clip appears in the following places using the 
display name instead of the original file name:

�� The Media Pool’s Icon view

�� The name bar of each clip in the Timeline

�� The Source Viewer title bar

�� The Display Name field of the Clip Attributes dialog’s Name panel

Switching Between File Names and Display Names
Since different tasks require different information, you have the ability to switch between using 
clip file names and display names. For example, finishing editors will probably have more 
reason to refer to the file name of each clip, making it easier to troubleshoot problems with 
reconforming and relinking. Creative editors, on the other hand, will want to use easier-to-read 
display names to make it easier to find what they need.

To switch between file names and display names:

�� Choose View > Show Display Names for Clip Titles to toggle between both naming 
conventions.

NOTE: You can also edit the display names of timelines, compound clips, and multicam 
clips, so that you can have two sets of naming conventions for these items, one for 
when you’re doing creative editing, and one for when you’re doing finishing tasks.
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Using Metadata to Define Display Names
If you’re an enthusiastic user of clip metadata (and you should be), you can use “metadata 
variables” that you can add into a field that let you reference other metadata for that clip. For 
example, you could add the combination of variables and text seen in the following screenshot. 
Variables, once they’ve been entered, are represented as graphical tags shown with a 
background, while regular text characters that you enter appear before and after these tags.

Variables and text characters entered to create  
a display name based on a clip’s metadata

As a result, that clip would display “12_A_3” as its name if scene “12,” shot “A,” and take “3” 
were its metadata. When you do this, you can freely mix metadata variables with other 
characters (the underscore, as in the example above) to help format the metadata to make it 
even more readable. 

Every single item of metadata that’s available in the Metadata Editor can be used as a variable, 
and several other clip and timeline properties such as the version name of a clip’s grade, a clip’s 
EDL event number, and that clip’s timeline index number can be also referenced via variables. 

Since the use of metadata variables is a great way to automatically generate names for multiple 
clips, you may find it more useful to add metadata variable-driven display names by selecting all 
of the clips you want to edit, and opening the Clip Attributes window. By editing the Display 
Name field found in the Name panel, you can add a single display name to all selected 
clips at once.

To add a variable to a text field that supports the use of variables:

1	 Type the percentage sign (%) and a scrolling list appears showing all variables that are 
available. 

2	 To find a specific variable quickly, start typing the characters of that variable’s name 
and this list automatically filters itself to show only variables that contain the characters 
you’ve just typed. 

3	 Choose which variable you want to use using the Up and Down Arrow keys, and press 
Return to choose that variable to add.

As soon as you add one or more metadata variables to a clip’s Display Name column and press 
return, the string is replaced by its corresponding text. To re-edit the metadata string, simply 
click within that column and the metadata variables will re-appear. Be aware that, for clips 
where a referenced metadata field is blank, no characters appear for that corresponding 
metadata variable in the Display Name column.

The variable list that appears  
when you type the % character
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To remove a metadata variable:

�� Click within a field using variables to begin editing it, click a variable to select it, and 
press Delete.

For more information on the use of variables, as well as a list of all variables that are available in 
DaVinci Resolve, see Chapter 44, “Using Variables and Keywords.”

Editing Clip Metadata
Whether you’ve imported media in preparation for editing, or you’ve imported a project for 
grading that resulted in media being imported automatically, once you’ve added clips to the 
Media Pool, it would behoove you to consider taking the time to review and add metadata to 
your clips. 

At the very least, it would be valuable for you to use the Metadata Editor that’s available in 
either the Media page or the Edit page to add information to each clip such as a Description, 
Shot and Scene designations, Take information, and possibly some useful keywords such as 
Character Names, Shot Framing, Interior or Exterior keywords, et cetera. If you’re especially 
ambitious (or you have a very responsible assistant), you could go further and add Shoot Day, 
Camera Type, Audio Notes, and other valuable information. Much of the metadata that is useful 
in the day to day work of editing and grading can be found in the Shot & Scene group, but there 
are many other potentially useful groups as well that you should explore.

Keep in mind that the more metadata you associate with each clip, the more methods you have 
at your disposal for creating custom Smart Bins (for editing) and Smart Filters (for grading) with 
which to zero in on the clips you need for any given situation. This will not only make it easier to 
find what you need, but it’ll help you to work faster.

For example, if you’ve entered enough metadata, then you can create multi-criteria Smart Bins 
or Smart Filters that let you find the equivalent of “every close-up of Sally inside the diner,” or 
“every long shot of Antonio outside in the parking lot.” In a documentary, you could easily 
isolate “every interview shot of Louis from camera 1,” or “every B-roll clip with Robyn.” All of this 
will help you to find media faster for editing, or to quickly isolate similar clips that you need to 
match together for grading.

Using the Metadata Editor
Whenever you select a clip in the Media Pool, its editable metadata appears in the 
appropriately named Metadata Editor (so long as it’s displayed). You can use this editor to 
further massage the metadata of the clips in a project, adding information on set that will be of 
help later during editing and finishing. 

By default, clips initially appear with a set of clip metadata called “Clip Details,” that shows some 
of the most fundamental details of the clip such as start and end timecode, duration, bit depth, 
et cetera.

Because there are so very many metadata fields that are available, two pop-up menus at the 
top right of the Metadata Editor let you change which set of metadata is displayed.

�� Metadata Presets (to the left): If you’ve used the Metadata panel of the Project Settings 
to create your own custom sets of metadata, you can use this pop-up to choose which 
one to expose. Surprisingly enough, this is set to “Default” by default.

�� Metadata Groups (to the right): This pop-up menu lets you switch among the various 
groups of metadata that are available, grouped for specific tasks or workflows.
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Metadata categories pop-up menu

If you want to see a list of every piece of metadata in a clip, you can choose All Groups. 
Otherwise, you can choose any set of metadata to narrow your focus to just those items of 
information.

To edit metadata for a single clip:

�� Select any clip in the Media Pool, and edit whatever metadata fields you require. The 
edited metadata is immediately saved.

To edit metadata for multiple clips:

1	 Choose a metadata set using the pop-up menu in the Metadata Editor.

2	 Select multiple clips in the Media Pool by Shift-clicking, Command-clicking, or dragging 
a bounding box around them.

3	 Edit whichever metadata fields you want to. Checkboxes are automatically turned on 
for any metadata fields you edit.

4	 When you’re done, always click the Save button at the bottom of the Metadata Editor. 
When you edit metadata for multiple clips at once, it’s not automatically saved if you 
create a new selection in the Media Pool without clicking the Save button first.
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Editing Keywords
While most metadata in the Metadata Editor is edited via text fields, checkboxes, or multiple 
button selections (such as Flags and Clip Color), the Keyword field is unique in that it uses a 
graphical “tag” based method of data entry. The purpose of this is to facilitate consistency with 
keyword spelling by making it easy to reference both a built-in list of standardized keywords, as 
well as other keywords that you’ve already entered to other clips.

Once added, keywords are incredibly useful for facilitating searching and sorting in the Media 
Pool, for creating Smart Bins in the Media and Edit pages, and for use in Smart Filters on the 
Color page. Reaping these benefits by adding and editing keywords is simple, and works 
similarly to the method of entering metadata variables that’s described in Chapter 44, “Using 
Variables and Keywords.”

To add a keyword:

1	 Select the Keyword field of the Metadata Editor, and begin typing the keyword you 
want to use. As you begin typing, a scrolling list appears showing all keywords that are 
available using the string of characters you’ve just typed.

2	 To find a specific keyword in the list, start typing that keyword’s name and this list 
automatically filters itself to show only keywords that contain the characters you’ve just 
typed. Choose which keyword you want to use in the list using the Up and Down Arrow 
keys, and press Return to choose that keyword to add.

 

The keyword list that appears when you type within the Keyword field

As soon as you add one or more keywords, they appear as a graphical tag. To re-edit any 
keyword, simply click anywhere within the Keyword field to edit it.

To edit a keyword:

�� Double-click any keyword to make it editable, then edit it as you would any other piece 
of text, and press Return to make it a graphical keyword tag again.

To remove a keyword:

�� Click any keyword to select it, and press Delete.
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Importing and Exporting 
Media Pool Metadata
Once you’ve taken the trouble to add metadata to the clips in your project, DaVinci Resolve 
makes it possible to export metadata from the Media Pool of one project for import into the 
clips of another project, for instances where you need to move metadata around. 

For example, a DIT might have entered a lot of metadata to the DaVinci Resolve project used 
for generating dailies, but then an impatient editor might have created a separate project to 
begin editing those dailies. Instead of requiring the editor to enter each clip’s metadata all over 
again, you can export the metadata from the DIT’s project and import it into the editor’s new 
project, automatically matching the relevant metadata to each corresponding clip.

To export Media Pool metadata:

1	 Open a project containing Media Pool metadata you want to export.

2	 Optionally, select which clips in the Media Pool you want to export metadata for.

3	 Choose File > Export Metadata From > Media Pool to export metadata from every clip 
in the Media Pool, or choose File > Export Metadata From > Selected Clips to only 
export metadata from clips you selected in step 2.

4	 When the Export Metadata dialog appears, enter a name and choose a location for the 
file to be written, then click Save. All metadata is exported into a .csv file that can be 
viewed and/or edited in any spreadsheet application.

Tips For Editing Metadata

Editing metadata is like taking vitamins. Nobody wants to, but you know you probably 
should. To encourage you to undertake this task so you can reap the benefits, here 
are a few pointers.

�� Don’t start editing until you review your footage and add metadata. If you get 
into the habit of entering your clip metadata before you get preoccupied with 
your edit, you’ll be in a much better position to edit faster using organizational 
tools that leverage the metadata you’ve entered.

�� Enter metadata starting with groups of clips and then moving to individual clips. 
Since the Metadata Editor lets you add metadata for multiple selected clips at 
once, it becomes easy to select groups of clips based on their thumbnails for 
entering information such as Scene designations, Interior or Exterior keywords, 
Character keywords, and Framing keywords. You’ll be surprised how fast this 
goes, and how useful this information is later on, for both editing and grading.

�� After you’ve entered all the metadata you can in groups of clips, then switch 
to entering clip-specific metadata such as Shot designations, Take numbers, 
descriptions of action, and other clip-specific keywords.

�� There’s no right or wrong way to edit or use metadata, but a lack of consistency 
will make it less useful. For example, if you’re identifying each clip that takes 
place at the same diner, try to use the same keyword or descriptive text. If you 
call half the shots “diner” and the other half “restaurant,” your ability to easily 
search for all the diner shots will be compromised.
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To import Media Pool metadata:

1	 Open a project containing clips you want to populate with imported metadata.

2	 Optionally, select which clips in the Media Pool you want to import metadata to.

3	 Choose File > Import Metadata To > Media Pool to import metadata to potentially every 
clip in the Media Pool, or choose File > Import Metadata To > Selected Clips to only 
import metadata to clips you selected in step 2.

4	 When the Import Metadata dialog appears, choose a metadata .csv file to import, and 
click Open.

5	 When the Metadata Import dialog appears, choose the Import Options you want to use 
to match the .csv file’s metadata to the correct clips in the currently open project. By 
default, Resolve tries to use “Match using filename” and “Match using clip start and end 
Timecode” to match each line of metadata in the .csv file with a clip in the Media Pool, 
but there are other options you can use such as ignoring file extensions, using Reel 
Name, and using source file paths.

6	 Next, choose which Merge Option you want to use in the Metadata Import dialog. 
There are three options:

�� Only update metadata items with entries in the source file: The default setting. Only 
updates a clip’s metadata if there’s a valid entry in the imported .csv file. Other clip 
metadata fields are left as they were before the import.

�� Update all metadata fields available in the source file: For each clip that corresponds 
to a line of metadata in the imported .csv file, every single metadata field referenced 
by the .csv file is overwritten, regardless of whether or not there’s a valid entry for 
that field.

�� Update all metadata fields available in the source file and clear others: For each clip 
that corresponds to a line of metadata in the imported .csv file, every single metadata 
field referenced by the .csv file is overwritten, regardless of whether or not there’s a 
valid entry for that field. Furthermore, metadata fields that aren’t referenced by the 
imported .csv file are cleared of whatever metadata was there before.

The Metadata Import dialog that lets you choose options  
for how to match and merge imported metadata

7	 When you’re finished choosing options, click Ok and all available metadata from the 
source .csv file will be imported.



203Chapter 9  –  Working With Media

Syncing Audio
If you’re processing dailies for a shoot that used dual-system recording, where audio is 
recorded to a separate device than video, you can sync the dailies in DaVinci Resolve in one of 
two ways. Synced clips can be output as media files with embedded audio, or output to tape, 
whatever your client requires.

Syncing Dailies Using Timecode
Ideally, if the sound recordist on set was highly organized, and the camera and audio recorder 
both used synchronized timecode, you can use a single command to automatically sync every 
clip in a Timeline to a bin of Broadcast .wav files that have matching timecode.

To batch sync dailies using timecode:

1	 Create a new project, open to the Media page by default, and import the video media 
you need to sync into any bin of the Media Pool.

2	 Import the matching Broadcast .wav files into the same bin as the accompanying video 
media you imported in Step 1. If you want to stay more organized, you can create 
another bin to contain the audio clips, but it must be inside the bin that contains the 
video files. The audio bin can be named anything you like.

Organizing production audio in a bin created  
within the accompanying camera media bin

3	 Right-click the bin containing the matching audio and video clips, and choose one of 
the following commands from the contextual menu:

�� Auto-Sync Audio Based on Timecode: Replaces each video clip’s previous audio 
channels with audio channels from the newly synced .wav files

�� Auto-Sync Audio Based on Timecode and Append Tracks: Adds new channels 
in addition to the audio channels that were previously in the media file. The newly 
synced channels are added to an additional track, so when edited into the Timeline, 
a clip that’s synced this way appears with one video clip and two audio clips 
that occupy two different audio tracks, so you can edit the camera original audio 
independently from the synced audio.

Every clip in the selected bin for which there was an accompanying Broadcast .wav file 
with matching timecode is immediately synced with an audio track. All synced clips 
appear with an audio icon at the bottom left in the Media Pool when icon view is 
selected. Now that the clips are synced, you can edit them in the Edit page, or use the 
Deliver page to export offline dailies or online media with embedded synch audio for 
use in other applications.



204Chapter 9  –  Working With Media

Syncing Dailies by Matching Waveforms
If you don’t have matching timecode in the audio and video source clips you’re syncing, but you 
had the foresight to record camera audio at the same time as the dual source production audio 
you want to sync to, DaVinci Resolve can use waveform syncing to compare the audio 
waveforms of your audio and video source files, and sync the ones that match.

To batch sync dailies using waveform syncing:

1	 Create a new project, open to the Media page by default, and import both the video 
and audio media you need to sync. There’s no need to organize your files in any 
particular way, but it’s not a bad idea, on multi-day shoots, to organize the audio 
and video files so that it’s easy to select all of a single day’s clips at once so that 
you can sync your files in smaller batches. Even organizing your clips by scene can 
make waveform syncing go faster by reducing the number of files that need to be 
compared at once.

2	 If you’ve placed the audio and video into separate bins, then you can Command-click 
both bins in the bin list to select them and expose all of their contents in the Media 
Pool. If you placed your media in the same bin, this is not necessary.

3	 Select one of the exposed clips in the Media Pool, and press Command-A to select all 
audio and video clips you want to sync.

4	 Right-click one of the selected clips, and choose one of the following commands from 
the contextual menu:

�� Sync Video and Audio Clips: Analyzes and compares the waveforms of each of the 
selected clips, and replaces each video clip’s previous audio channels with the newly 
synced .wav files.

�� Sync Video and Audio Clips and Append Tracks: Adds new channels in addition 
to the audio channels that were previously in the media file. The newly waveform-
synced channels are added to an additional track, so when edited into the Timeline, 
a clip that’s synced this way appears with one video clip and two audio clips that 
occupy two different audio tracks, so you can edit the camera‑original audio 
independently from the synced audio.

A progress bar dialog appears, showing you how long the syncing operation will take. 
When it’s complete, your clips will be synced.

Progress dialog for syncing dialog using waveforms

TIP: After syncing, you may be notified via a dialog that one or more clips could not be 
synced. Note these clips, as it may be possible to use waveform syncing more 
successfully on just the selected pair of audio and video items that belong together.
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Manually Syncing Clips in the Timeline
If you have a collection of WAV or AIFF audio files with video source media that lacks matching 
timecode, you need to manually sync each pair of media files together, one-by-one, using a 
sync reference such as the clap of a clapperboard, or any other sharp sound with a distinct 
audio/visual correspondence.

To manually sync dailies:

1	 Create a new project, and import the video media you need to sync into the Media 
Pool. If a dialog appears asking whether or not you want to update the project to match 
the media, click OK.

2	 If you want to stay organized, create a second bin in the Media Pool, named Audio 
Clips, and import the matching Broadcast .wav files into it. The name of the bin is not 
important, and having all the audio in one bin is simply a matter of convenience.

3	 Click the Waveform button at the top of the Audio Panel, which lets you view and scrub 
along the waveform of audio clips you select in the Media Pool.

4	 Select a video clip to sync, and move the Viewer playhead to line up with the first visual 
sync point in the first clip. This could be the clap of a clapper board, the red flash of 
a tablet computer’s slate app, a hand clap, or any clear visual cue to which there is a 
corresponding audible sound.

5	 Now, select whichever audio clip corresponds to the current video clip in the Viewer, to 
open its waveform into the audio panel.

6	 Use the Audio panel transport controls and scrubber bar in the Source Viewer to move 
the playhead to the audio sync point that corresponds to that video sync point. This 
may be a clap, a beep, or some other staccato sound that’s easy to sync to. As you play 
through the clip, the bottom half of the Viewer shows a zoomed out waveform for the 
entire clip, while the top half of the Viewer shows a zoomed in section of the waveform 
that immediately surrounds the playhead. Hopefully, the sync point you’re looking for is 
a distinct, loud spike somewhere towards the beginning or the end (in the case of a tail 
slate) of the audio clip.

Aligning video and audio sync points with the Audio Panel Set to show the Waveform panel

7	 When you’ve found the audio sync point that matches the video sync point, click the 
Link/Unlink Audio button at the bottom right of the audio panel to embed the now 
synched audio into the video clip.

Clicking the sync link button to lock sync
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The audio and video items are linked. At this point, you can use the newly synced clips 
in the Edit page, and use the Deliver page to export offline or online media with 
embedded audio for editing.

Offsetting the Sync of Previously Synched Clips
If you need to offset the audio (or stereo 3D) sync of the items that make up a clip later on, you 
need only select the synced clip you want to resync in the Media Pool, then click the Waveform 
button of the Audio Panel to show the clip’s audio waveform, turn off the linked clip button, 
change either the audio or video sync points, and turn the linked clip button back on again. 

You can also use two sets of commands for slipping the sync of any clip:

�� Trim > Slip Audio > Slip Audio One Frame Forward/Reverse: (Option-period and 
Option-comma) Slips the audio/video sync of any clip in whole frame increments.

�� Trim > Slip Audio > Slip Audio One Subframe Forward/Reverse: (Option-right arrow and 
Option-left arrow) Slips the audio/video sync of any clip in 1/10th frame increments.

�� Trim > Slip Eye > Slip Eye One Frame Forward/Reverse: (Command-Option-period and 
Command-Option-comma) Slips the sync relationship between the eyes within a stereo 
clip in whole frame increments.

Changing Clip Attributes
Using the Clip Attributes window, you can alter additional attributes for multiple clips all at once. 
This window has some overlap with other clip attributes that are editable directly from 
submenus within the Media Pool clip contextual menu.

To edit the attributes of one or more clips in the Media Pool:

1	 Select one or more clips in the Media Pool by Shift-clicking, Command-clicking, or 
dragging a bounding box around them.

2	 Right-click one of the selected clips, and choose Clip Attributes.

3	 Click to open the panel of the attributes you want to edit. If you’ve selected multiple 
clips, then making your alterations automatically checks the box of the attributes 
being changed.

4	 When you’re finished, click OK to accept the changes.

Starting in Resolve 12.5, you can also edit select clip attributes for clips that have been edited 
into the Timeline.

To edit the attributes of one or more clips in the Timeline:

1	 Select one or more clips in the Timeline by Shift-clicking, Command-clicking, or 
dragging a bounding box around them.

2	 Right-click one of the selected clips, and choose Clip Attributes.

3	 Click to open the panel of the attributes you want to edit. If you’ve selected multiple 
clips, then making your alterations automatically checks the box of the attributes 
being changed.

4	 When you’re finished, click OK to accept the changes.

The Clip Attributes window has five sets of attributes that you can edit.
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Video Attributes
These affect individual clip frame rate, geometry, and data levels.

�� Video Frame Rate: In cases where a clip’s frame rate was specified incorrectly in 
another application, or if there is no frame rate metadata available at all, you can 
change the frame rate here.

�� Levels: In certain circumstances, you may find that you need to manually choose 
appropriate data levels for clips that are not being interpreted correctly, choosing 
between “Video Level” and “Data Level.” For more information on this setting, and 
how it affects the image data in your project, see Chapter 6, “Data Levels, Color 
Management, ACES, and HDR.”

�� Pixel Aspect Ratio: In projects using a mix of media with different frame sizes, you can 
assign specific pixel aspect ratios using this pop-up menu.

The Video panel of the Clip Attributes Window

�� Horizontal and Vertical Image Flip: Modifies the horizontal and vertical image flip 
camera metadata for r3d clips, which is useful for stereoscopic 3D projects shot with a 
mirrored camera rig that reverses the media from one eye, or in cases where steadicam 
rigs result in upside-down clips. These settings are different from the Flip Image 
controls in the Sizing palette of the Color page.

�� Input Sizing Preset: You can use this panel to assign a Sizing palette preset to select 
clips. For example, if you have a special Input Format Preset for standard definition PAL 
widescreen clips that you’ve edited into a high definition project, you can do a sort in 
the Media Pool to isolate them, and then select them all and apply this preset.
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�� Alpha Mode: The options presented here depend on the format of the clip you’ve 
selected, since only certain formats (such as ProRes 4444, QuickTime Animation, 
OpenEXR, TIFF sequences, et cetera) are capable of containing alpha channels. If 
you’ve imported clips with embedded alpha channels, this panel lets you enable or 
disable their use in Resolve (by choosing None), choose the type of alpha channel 
(Premultiplied or Straight), or invert the alpha channel. If you select a clip that doesn’t 
contain an alpha channel, then most of these options don’t appear.

The Alpha Mode options that are available when a clip has an embedded alpha channel

�� Field Dominance: By default, the Auto setting enables Resolve to automatically 
determine whether a particular clip is Upper- or Lower-field dominant. If this automatic 
determination is wrong, you can choose Upper or Lower to manually override this.

�� Enable Deinterlacing: (only available in Studio version) This checkbox is only enabled 
if “Enable video field processing” is turned off in the Master Project Settings. Turning 
the “Enable Deinterlacing” checkbox on sets Resolve to deinterlace clips using the 
“Deinterlace quality” setting that’s located in the Image Scaling panel of the Project 
Settings. Normal is a high-quality deinterlacing method that is suitable for most clips, 
while High is a more processor-intensive method that can sometimes yield better 
results, depending on the footage.

Audio Attributes
The Audio panel lets you alter the channel format and channel assignments for one or more 
clips. These settings affect what appears in the audio tracks of the Timeline when you edit a 
clip into a program. When you first import clips into the Media Pool, you can use the Audio 
Attributes panel to define which embedded audio tracks can be used for editing, and how they 
will appear in the Timeline. 

The Audio panel of the Clip Attributes Window
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�� Channel Format: A pop-up that lets you choose what format each specified track of a 
clip’s audio uses. The setting you choose here affects how many channels appear in 
the Channel Assignments list below, as well as what kind of Timeline audio track will be 
required to expose all channels of that clip. If you choose a Channel Format with fewer 
channels than are embedded in a clip, all extraneous channels will be disabled. The 
available options are:

�� Stereo: Appropriate for clips with two-channel left/right audio

�� Mono: Appropriate for single-channel clips

�� 5.1: Automatically used for any clips with more then two channels, appropriate for 5.1 
surround mixes.

�� Adaptive: Appropriate for multiple-mono production audio, such as multi-channel 
recordings where a boom microphone, two separate lavaliere microphones, and a 
mix-down track are recorded simultaneously.

�� Audio Tracks: Shows how many tracks of embedded audio a clip has, this parameter 
is freely editable. Each track specified will result in an additional linked audio item 
being edited into an additional audio track when this clip is edited into the Timeline. 
For example, if you have a multi-channel production recording with four different 
microphones, you can set the Channel format to Mono, then specify 3 Audio Tracks 
and assign each channel to a separate track to expose each channel as an individual 
audio clip in the timeline for purposes of editing each microphone separately.

A clip with a single track of two-channel stereo audio at left, compared to a clip 
with two tracks of single channel mono audio at right

�� Audio Channels: Defined by the Channel Format, shows how many channels will be 
embedded in each Track. This value is only editable if the Channel Format is set to 
Adaptive, in which case it can be set from 1 to 16.

�� Source Channel Assignments list: This list shows an entry for each track made 
available by the selected Channel Format. A pop-up menu lets you change which 
embedded clip audio channel is mapped to each available track as determined by.
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Timecode Attributes
If you find yourself dealing with clips that have incorrect timecode, or timecode with an 
incorrect relationship to the EDL, XML, or AAF project you’ve been given, you can use these 
attributes to modify the timecode and reel name of clips in the Media Pool. None of these tools 
alter the source media on disk. They simply change the timecode metadata in your Resolve 
project, which by extension affects the timecode of any media you render.

The Timecode panel of the Clip Attributes Window

�� Current Frame Timecode: Lets you assign a new time for the timecode at the currently 
viewed frame of the clip.

�� Slate Timecode: In situations where source media comes from a shoot where a 
timecode slate was used during the shoot, then you can assign the slate timecode as 
a second timecode track that can be used for various operations, without changing the 
primary timecode of the clip, which may already be in use for program sync. 

�� To set appropriate Slate timecode, select a clip in the Media Pool with a visible 
timecode slate, and move the playhead to a frame where the timecode in the slate is 
clearly readable. Then, open the Timecode panel of the Clip Attributes window, and 
type the timecode value you see in the image into the Slate Timecode field.

�� Offset Source Timecode: If an entire set of clips has timecode that’s merely offset, you 
can correct the timecode offset for as many selected clips as you like.
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Reel Name Attributes
The “Assist using Reel Names” checkbox in the Master Project Settings panel of the Project 
Settings is an extremely important setting for controlling how the conform process works. By 
default it’s turned off, and Reel Names are left blank. This is fine for conform workflows where 
all you need is the file path or file name and source timecode to successfully identify which 
media files correspond to what clips. However, if you need more information than that to 
reconform the clips in your project, you can turn on the “Assist using Reel Names” checkbox to 
enable Resolve to use one of four different methods to automatically define reel names for 
every clip in the Media Pool.

Using the Clip Attributes dialog, you also have the option of manually defining how one or more 
selected clips in the Media Pool have their Reel Names defined. This is useful when there are 
certain clips in a project that need to use a different method of reel name extraction, or 
manually entered reel names. Once you’ve used Clip Attributes to change the reel names of 
clips, those clips no longer automatically update when you change the “Assist using Reel 
Names” options in the Project Settings.

The Reel Name panel of the Clip Attributes Window

You must first turn on “Assist using Reel Names” in the Master Project Settings window, and 
choose a Reel Assist setting, for the reel name attributes in the Clip Attributes window to 
be editable.

�� Source clip file pathname: Obtains the reel name by extracting it from each media 
file’s path. This makes it possible to extract a reel name from all or part of the file name, 
or from all or part of the name of any folder in the path that encloses that file. This 
extraction is defined using the Pattern field.

�� Pattern: A code that defines how a reel name should be extracted from the source clip 
pathname. More information about creating patters appears later in this chapter.
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�� Media Pool bin name: The reel name is obtained from the name of the bin in the 
Media Pool that encloses that clip. For example, in a stereoscopic workflow you might 
want to export offline stereo media with the “Left” and “Right” bin names in which 
they’re organized as reel names. Another example would be organizing VFX being 
incrementally processed in individually named bins, such as “VFX_Tuesday_10-12.”

�� Embedding in Source clip file: Useful for file formats where the reel name is embedded 
within the media file itself. CinemaDNG and other digital cinema cameras, QuickTime 
files created by Final Cut Pro, and DPX frame files are formats that can contain reel 
name header data.

�� Source clip filename: If there is no defined reel number, often it’s easy to just use the 
Source clip filename.

�� User Defined: This option is only available when you manually alter the reel name for 
one or more selected clips in the Media Pool using the Clip Attributes dialog. Choosing 
User Defined lets you type any string of text you like to use as the reel name.

Relinking Media Simply
DaVinci Resolve keeps track of the relationship between clips in your project and their 
corresponding source media on disk. If, for whatever reason, source media that links to clips in 
your project becomes unavailable, Resolve has several different methods of relinking those 
clips in the Media Pool.

This section summarizes the top two methods of relinking. For more comprehensive information 
on conforming projects and relinking media, see Chapter 22, “Importing Projects and 
Relinking Media.”

Relink Selected Clips
The easiest method of relinking clips in your project that have gone offline is to use the 
appropriately named “Relink selected clips” command. This is the most flexible method of 
relinking clips in your project with clips in a file system directory of your choice, using file name 
and timecode as the primary criteria for drawing a correspondence between each clip and the 
corresponding media file on disk. When you relink clips this way, the original file path in Resolve 
is ignored, so this is a good command to use to relink to media that’s been reorganized on disk.

To relink selected clips:

1	 Select one or more offline clips to relink, or select a bin in the Media Pool bin list 
that contains clips you want to relink, then right-click one of the selected clips or the 
selected bin, and choose “Relink Selected Clips” from the contextual menu.

2	 When the Relink File dialog opens, choose a directory in which to look for the files you 
want to relink to, and click OK. Resolve attempts to find every clip with a matching file 
name in the subdirectories of the directory you chose, using the original file paths of 
the clips being relinked to do this as quickly as possible. By first looking for the clips in 
the directories they were originally in, relinking can be quite fast.

3	 If there are any clips that couldn’t be found using the method in step 2, you’re prompted 
with the option to do a “deep search” by a second dialog. If you click Yes, then Resolve 
will look for each clip inside every subdirectory of the directory you selected in step 2. 
This may take significantly longer, but should be completely successful so long as the 
media that’s required is within the selected directory structure.

4	 If there are still other clips that couldn’t be found, you’re prompted to either choose 
another directory altogether to continue searching, or quit.



213Chapter 9  –  Working With Media

Change Source Folder
If you’ve used your file system to move media that’s associated with a Resolve project, but you 
haven’t changed the directory structure with which it’s organized, you can use the “Change 
Source Folder” command to quickly relink selected clips in the Media Pool to the new file path 
of the media on disk, using the original file paths as a guide. This is a good relinking method to 
use, if possible, for projects on a SAN where you don’t want to risk the excessively long search 
times that could result from using the Relink command to examine a nested hierarchy of folders 
in a more flexible way.

To relink your Media Pool clips to a new location:

1	 Select one or more clips in the Media Pool, then right-click one of the selected clips, 
and choose “Change Source Folder” from the contextual menu. The Relink Media 
window appears displaying the original path for the material, with controls for choosing 
a new directory.

2	 Click the “…” button to the right of the “Change To” field, and then use the file 
navigation dialog to find the new location of the media file, select it, and click Open.

�� If you succeeded in finding the appropriate media file, click Change. Otherwise, 
click Cancel.

Locating Media Files in the 
Media Storage Browser and Finder 
If you find yourself needing to determine the location of a clip’s source media file on disk, you 
can right-click an item in the Media Pool and choose Reveal in Media Storage browser. The 
Library automatically opens to the folder containing the media file you’ve selected, with that 
media file selected in the Library browser to the right.

Another feature that’s only available for OS X systems is the ability to right-click an item in the 
Media Pool and choose Reveal In Finder. A file system window opens up, revealing the media 
file that clip is linked to.

Update Timecode from Audio – LTC
Some cameras do not offer the ability to sync to an external timecode source. Their recorded 
timecode may be time of day or free run timecode, but it would not be frame accurately synced 
to other cameras, the dual system audio recorder or the digital slate. This makes multi-cam or 
dual sound system syncing a time consuming manual operation.

DaVinci Resolve offers a solution to this problem if, by connecting an externally generated 
timecode to the camera audio input, the video that’s recorded by the camera has a timecode 
reference recorded on the audio track during the shoot. 

Select this clip, or clips, in the media pool, then right-click on one of the highlighted clips and 
select “Update timecode from audio - LTC.” Resolve automatically and instantly updates the clip 
timecode using the LTC it finds on the audio tracks. You can now use the clips as though they 
were synced on set.
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Changing Clip Thumbnails 
in the Media Pool
When the Media Pool is in Thumbnail mode, each clip is represented by a small image that 
defaults to the first frame of that clip. You can scrub the thumbnail of any clip to view its 
contents using the pointer after hovering over it for a moment. However, when you’re done 
scrubbing, moving the pointer away from any clip returns its thumbnail to the first frame of 
media, which may or may not be representative of its contents. You can change this, if you like.

To customize the thumbnail of any clip:

1	 Move the pointer over a clip you want to customize the thumbnail of.

2	 Hover for a moment, then scrub to a representative frame.

3	 Right-click that clip, and choose Set Poster Frame.

To clear the custom poster frame of any clip:

Right-click a clip and choose Clear Poster Frame.

Creating Subclips
Subclips give you another way of organizing media in the Media Pool, letting you break 
excessively long clips into shorter ones. For example, if the director of a project is fond of 
“rolling takes” where multiple takes are all recorded within a single clip, you can break these 
takes up by making them into subclips.

To create a subclip:

1	 Select any clip in the Media Pool to open it into the Viewer.

2	 Set In and Out points to define the section you want to turn into a subclip.

3	 Right-click the jog bar and choose Make Subclip. 

A new subclip appears in the Media Pool, automatically selected so that you can 
immediately edit its metadata in the Metadata Editor.

Once created, subclips appear and work like any other clip in Resolve.

Organizing Stereo 3D Media
When working with stereo media in DaVinci Resolve, one of the first tasks you must perform is 
that of syncing each stereo pair of clips to act as a single clip. This is easily accomplished so 
long as you’re careful about how you organize your media in the Media Pool.

Each set of right- and left-eye media should always be organized into separate left-eye bins and 
right-eye bins, to facilitate later syncing of these clips using the Stereo 3D Sync command in the 
Media Pool contextual menu. For more information about setting up media for stereo 
workflows, see the “Stereoscopic Workflows” section of Chapter 40, “Stereoscopic Workflows.”



215Chapter 9  –  Working With Media

Camera Raw Decoding
Camera raw media formats are so named because they capture raw color space data directly 
from the sensor of whatever digital cinema camera did the recording. Raw image data is not 
human readable, and must be debayered or demosaicked to convert the original raw data into 
image data that can be handed off to DaVinci Resolve’s image processing pipeline.

There are four ways you can control how camera raw media is debayered into a useful, 
“normalized” image for adjustment or output:

�� The Camera Raw panel of the Project Settings contain groups of parameters that 
correspond to every camera raw media format that’s supported by DaVinci Resolve. 
Using these parameters in the Camera Raw panel, you can override the original camera 
metadata that was written at the time of recording, and make simultaneous adjustments 
to all camera raw media throughout your project.

�� When you right-click one or more selected camera raw clips in the Media Pool, there 
are a series of “Edit Codec Settings” menu options corresponding to each supported 
camera format in the contextual menu that appears. Choosing one of these commands 
opens a Camera Raw window that exposes controls mirroring those found in the 
Camera Raw panel of the Project Settings.

�� The Camera Raw palette in the Color page lets you individually adjust Camera Raw 
parameters for individual clips in the Timeline.

When you use Resolve Color Management (RCM) in a project that uses Camera Raw 
formats, color science data from each camera manufacturer is used to debayer each 
camera raw file to specific color primaries with linear gamma, so that all image data 
from the source is preserved and made available to Resolve’s color managed image 
processing pipeline. As a result, the Camera Raw project settings and Camera Raw 
palette of the Color page are disabled, because RCM is controlling the debayering of 
all camera raw clips, and all image data from the raw file is available for conversion to 
the Timeline Color Space you choose to work with as you grade.

For more information about each of the Camera Raw formats that can be adjusted in DaVinci 
Resolve, see Chapter 4, “Camera Raw Settings.”


